SW4STM32 CubeMX 5.0 & TouchGFX 4.10 Integration

For STM32F429i-DISC1 Target Document by Mon2 version 1.0 12-22-2018

Credits: Thanks to Zhi Pang for your great posts that helped tremendously
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New Project from a Board —

New Project

I need to :

Start My project from MCU
ACCESS TO MCU SELECTOR

Start My project from STBoar.

ACCESS TO BOARD SELECTCR

Board Fi
R B O

Part Number Search ~

@ [2F429DISCOVERY -

Vendor >
Type v
Check/Uncheck Al
[ Discovery
MCU Series >
Other v
Price =299

Oscillator Freq. = 8 (MHz)

Peripheral ~

Button 0

1900000800

7y [ 3ZFA29IDISCOVERY

Boards List: 1 item

L | Oeriew ] 4 Harketing Status Unit Price (USS) lounied Device

Large Picture Docs & Resources [4] Datashest [ Buy

= Start Project
)

STMicroelectronics STM32F429I Discovery Board Support and Examples

Unit Price (USS): 29.9

Active
Product is in mass production
Mounted device: STU32F4207ITx

The 32F420IDISCOVERY kit leverages the capabilities of the STM32F429 high-performance microcontrollers, to allow users to easily develop rich applications with
advanced Graphic User interfaces.

With the latest board enhancement, the new STM32F4291-DISC1 order code has replaced the old STM32F4291-DISGO order code.
Features

On-board ST-LINK/V2-1

= Supply through ST-Link USB

= Extenal Supply - 3V and 5V

= IP3 (1dd) for current measurement

» 64 Nbits SDRAM (1 Mbit x 16-bit x 4-bank)

» High-Speed USB OTG with micro-AB Connector

® TFT LCD 2.4" QVGA (240 x 320), 262K colors RGB

32F429IDISCOVERY Discovery Active 299




, T e—— | G T
[ STM32CubeMX Untitled: STM32F42971T 32F429IDISCOVERY - A - _— = @] % |
oy x 4/

Untitled Pinout & Configuration GENERATE CODE

»
STM32 ﬁ i
CubaliX File Window Help

Project Manager

System view

System Core >

Analog >

Timers >

Connectivity >

Multimedia >

Security >

Computing >

M ’ STM32F429ZITx
Application > LOFP144

System Core
Analog
Timers
Connectivity
Multimedia
Security
Computing

Middleware

GRAPHICS
LIBJPEG

MBEDTLS
PDM2PCM

" LUSB HOS




sz @
CubeMX

File Window Help

- Pinout & Configuration

@ Pinout & Configuration @ Clock Configuration

System Core >
Analog >
Timers >
Connectivity >
Multimedia >
Security >
Computing >
Middleware hd

FATFS .

LIBJPEG

MBEDTLS

POM2PCM
Application >

Additional Softwares v Pin

GRAPHICS Mode and Configuration '
Graphics Framework|T0uchGFX

e
Display Interface |Display.r Parallel Interface using LTDC ’

Reset Configuration

& Touch ¢ A Platform Settings

¢Platform proposal

BSP

Name IPs or Components Found Solutions

Chip Select [GPIO:Output ~| [Undefined

WRX High [GPIO:Output ~| [Undefined

SPI_PIN  [Undefined ~| [No solution

RDX High [GPIO:Output ~| [Undefined

Reset Configuration

Configuration

& Platfon

¢ Platform proposal

«BSP

Name IPs or Components

Found Solutions

Chip Select [GPIO:Output

~| [PC2 [CSX [LCD-RGB_CSX]] %

WRX High [GPIO-Output

~| [PD13 [WRX_DCX [LCD-RGEI_WRX_DCX]]V

SPI_PIN  [Undefined

V| |Hc solution

RDX High [GPIO:Output | [PD12 [RDX [LDC-RGB_RDX]] V
]



o Pinout & Configuration

Analog >
Timers >

Connectivity u

-

@ CAN1
@ CAN2
@ ETH

@ 12C1
@ 12c2

SDIo
SPI
@ SPI2
SPI3
SP14

@ SPI6
@ UART4
UARTS
@ UARTT
@ UARTS

USART2
@ USART3
@ USARTS
@ USB_OTG_FS

Computing >

Middleware ~

FATFS

2 GRAPHICS
LIBJPEG

MBEDTLS
PDMZPCM

Application >

tled - Pinout & Configuration

@ Clock Configuration

Additional Softwares

SPI15 Mode and Configuration
Mode

Made [HalfDuplex Master >

Hardware NSS Signal [Disable >

Configuration

Reset Configuration

~ Basic Parameters

Frame Format Motorola

Data Size g Bits

First Bit MSB First
~ Clock Parameters

Prescaler (for Baud Rate) 16

Configuration

Reset Configuration

@ Platform S

¢Platform proposal

(BSP
Name IPs or Components

Chip Select [GPIO:Dutput

Found Solutions

~| [PC2 [CSX [LCD-RGB_CSX]]

WRX High [GPIO:Output ~| [PD13 [WRX_DCX [LCD-RGB_WRX_DCX]]

SPI_PIN  [SPI:Half-Duplex Master | [SPI5 V

RDX High [GPIO:Output | [PD12 [RDX [LDC-RGB_RDX]]
L _____________________________________________________________]




@ GRAPHICS

LIBJPEG

MBEDTLS
PDM2PCM

Application >

Reset Configuration

~ External application info
MName
Version
~ @ Location
Executable full name
~ Inputs

Physical Display X Siz

Physical Display Y

Execute [ ]

TouchGFX Designer

V4.10.0

® TouchGFXDesigner.exe notfound. Please select it. %

320

240



GRAPHICS Mode and Configuration :
Mode
Graphics Framework |T0uchGF)( V|
Display Interface Mr“ — - L -
m Open | 23
Look In | | designer V| B m B ﬁ—

| Resources
| Skins
[ TouchGFXDesigner-4.10.0. exe

‘ 2

File Name TouchGFXDesigner-4 100 exe |
Files of Types |.*TDuchGFXDesigner.*exe

N 3 MP

@ Platforn

Reset Configuration

Execute 9

~ External application info
TouchGFX Designer

Mame

Version V4.10.0
~ @ Location

Executable full name TouchGFXDesigner.exe not found. Please select it. II|
~ Inputs

Physical Display X

Physical Display ¥

Configuration

@ User Constants | @ Platform Settings

Reset Configuration

Execute (i ]

~ External application info

MName TouchGFX Designer

Version V4.10.0 %

~ @ Location
Executable full name chGFX¥\_10.0\designer\TouchGFXDesigner4.10.0.exe &

~ Inputs
Physical Display X Size

320

240

Physical Display ¥ Size



Reset Configuration “

® Fs z i ® Touc @ User Constants

¢ Platform proposal

-BSP

Name IPs or Components Found Solutions BSP API

Chip Select [GPIO:Output ~| [PC2[CSX [LCD-RGB_CSX]] ~| Unknown
WRX High [GPIO:Output ~| [PD13 [WRX_DCX [LCD-RGB_WRX_DCX]] ~| Unknown
SPI_PIN  [SPI:Half-Duplex Master ~| [SPI5 ~| Unknown
RDX High [GPIO:Output ~| [PD12 [RDX [LDC-RGB_RDX]] ~| Unknown

Project Manager

ck Issues

RTC Clock Mux

HSE_RTG

o
LsE O E To RTC (KHz)
®
o{ =]

180  |Ethernst PTP clock MHz)

HCLK to AHB bus, core,

To WDG (KHz) 180 | memorv and DMA (MHz)
System Clock Mux i~ 180 |To Cortex System timer (MHz)
Hsl
ko) FCLK Cortex clock (MHz)
Clock configuration - - APE1 peripheral clocks (MHz)
PLL Source Mux e Do you want to run automatic clock issues solver 7 APBI Timer clocks (WHz)

Otherwise you can do it later by clicking on button “Resolve Clock Issues” APB2 peripheral clocks (WHz)

Input fraquency
APE2 timer clocks (MHz)

3 - - ABMHz clocks [MHz)
fource Mux
"o
—-I:l 125 clocks (MHz)

4-26 MHz [ Do not show this message again.

" [0 Remember my decision for ne

"N L R
- [B_FLzsc | 1 :
12 IR
PLLIZS - N
""" le) SAL-A clocks (MHz)
MCO? source Mux
z o< = [ )
(o] SA4-B source Mux
o -
FLLCLK
\9 Ext.clock
Q ! SAL-B clocks [MHz)
MCO1 source Mux
LsE T — ] PLLSAIGLK [ 1 .
Q | XB0 14 ¢ = 1 1 [ ] 2
HSE “N )
Ole——o
il - + : PLLLCDCLK
LJ 15~ o 14 ~] ..I 5 LCD-TFT clocks {MHz)
~ PLLSAI R




Project Manager

Y] Resalve Clock Issues @ a

RTC Clock Mux

[e]

RTC

o _..I:l To RTC (KHz)
El Ethernet FTR clock (MHz)
L)
~ . ) HCLK to AHE bus, core.
To TWDG {KHz) memory and DA (HHz)
System Clock Mux o~ To Cortex System timer (MHz)
HSl
o] FELK Cortex clock [MHz)

SYSCLK (MHz) | AHB Frescaler HCLK (MHg) APE1 Prescaler

APB1 peripheral clocks (MHz)

72

PLL Source Mux APBA Timer clocks (MHz)

L
e

APB2 peripheral clocks (WHz)

APBE2 timer clocks (MHz)

42 | 48MHz clocks (MHz)

125 source Mux

Main PLL ‘a

125 clacks (MHz)

SAI-A source Mux

PLLI2S

SAl-4 clocks (MHz)

MCOZ source Mux

Change

SA-B source Mux

PLLIZSCLK

to

—:l SAI-E clocks (MHzZ)
o] C 6 Mhz !

MCO1 source Mux

[e]

X

PLLLCDOLK ————
iz v q 25 |LCD-TFT clocks (MHz)

) e o

PLLSAI iR




Clock Configurati

a

RTC Clock Mux

HSE_RTC
= (o]

i |

E—

Resolve Clock Issues

_.:| To RTC (KHz)

Project Manager

jo;

72 |E|neme¢ FTF clock (MHz)
HCLK to AHB bus, core,
memary and DIA iz
To Cortex System timer (MHz)

FCLK Cortex clock (MHz)

APBA peripheral clocks (MHz)

APBA Timer clocks (MHz)

APB2 peripheral clocks (MHz)

APB2 timer clocks (MHz)

LsI RC
» To IWDG (KHz)
32 KHz
Mo~
HsIRC System Clock Mux
Hs|
e SYSCLK (MHz) | AMB Frescaler  HCLK (MHz) AFE1 Frescaler
! [0}
PLLCL
PLL Source Mux ®
.
i4 ~ X72 ~v 12~
[ ) M N "
13w
Main PLL e

48MHz clocks MHz)

N
{ = |
125 source Mux

(o]

—-l:l 125 clacks (MHz)

1 FLLIZSCLK

SAI1-A source Mux

PLLIZS g N
0 — o SAl-A clocks (MHz)
MCO2 source Hux
SYSCLK
SAH-B source Mux
PLLZSCLK [
Ext.clock
SALB clocks (WHz)
MCO1 source Hux ':|
LSE [ ! 1
o [x60 ~ vl
N a
O
o FLLLCDOLK |
s vl——s{ s ] —i LCD-TFT clocks (MHz)
ol FLLSA TR

10



Pinout & Configuration

Clock Configuration

Additional Softwares

v Pinout

S —

System Core >
Analog >
Timers >
Connectivity >
Multimedia >
Security >
Computing >
Middleware V

LIBJPEG

MBEDTLS
PDM2PCM

<

Application >

GRAPHICS Mode and Configuration

Graphics Framework [TouchGFX

Display Interface |Display Parallel Interface using LTDC

Reset Configuration

Configuration

@ Platfor

~ Stack Name
Mame

~ Physical Display Size
Width
Height

~ Frame Buffer

LTDC Pixel Format(Setin LTDC)

Frame Buffer Color Format
Color Frame Buffer Depth

240

Touch y

320

240 «

320

LTDC_PIXEL_FORMAT_RGB5G5

RGB5G5
16

11



Configuration

Reset Configuration

® Parameter Settings @ TouchG @ lUser Constants @ Platform Settin

[Configure the below parameters - |

Q[Search(CtitF) | @  © L
~ Stack Name

MName TouchGFX
~ Physical Display Size

Width V/
Height 320

~ Frame Buffer
LTDC Pixel Format(Setin LTDC) LTDC_PIXEL_FORMAT RG

Frame Buffer Color Format RGBE6S
Color Frame Buffer Depth 16
Color Frame Buffer Start Address(Setin LTDC)
Buffers Count Double Buffered
~ Bitmap Cache Settings
Bitmap Cache Address 0
Bitmap Cache Size 0
Bitmap Objects Count 0
~ Instrumentation
Timer For Instrumentation Timer 1
~ LCD Driver
Use ilig341 Enabled
~ SDRAM Instances
SDRAM instance SDRAM1_BANKZ
SDRAM Refresh Count 1386

S STM32CubeMX Untitled STM32FA29Z1Tx

SHJ]I;;IA? File Window Help ‘f’ n s ,

Untitled - Project Manager GENERATE CODE

Pinout & Configuration Clock Configuration Project Manager

Project Settings -
Project Name
[my_SW4STM32_STM32F429i_DISC1_project] |

Project Location

[C:\TouchGFXProjectst
Application Structure
[advanced ~| 01 Do not generate the main()
- Toolchain Folder Location Important!!!
SELLRCEULIECIN | (C:iTouchGFXProjects\my_SWASTM32_STM32F429i DISCT_projecti\
Toolchain / IDE
[swasTma2 ~ | O Generate Under Root
Linker Settings

Minimum Heap Size ox200
Minimum Stack Size oxa00 ]

Advanced Settings

Meu and Firmware Packag
Mcu Reference
ISTM32F429ZITx

Firmware Package Name and Version
STM32C V1.23.0 Use latest available version

5 FW_F4

Use Default Firmware Location I

Browse

Use a fresh workspace for this tutorial.

File -> Save Project (CTRL+S)

12



[lssTM32CUbEMX my_SWASTMB2. STMAZE:

>
STM32 ﬁ i i
e File Window Help

STM32F42971Tx 9 [ my_SWASTM32_STM32F429i_DISC1_projectl.ioc - Project Manager

Pinout & Configuration Clock Configuration Project Manager

Generating user source code. .. |

- &/

@ Code Generation | £ J

o The Code is successfully generated under C:/TouchGFXProjects/my SWASTM32 STM32F429i DISCA_project

e A
[=[=@] = |
—~—
\../U | J » Computer » Local Disk (C:) » TouchGFXProjects » my SWASTM32_STM32F429i_DISC1 projectl » - | L | ‘ Search my SW4STM32 5TM32F429( Di... 2 |
Organize « Includein library « Share with + Burn Mew folder = » [ @
@ Documents i MName : Date modified Type Size
J’ Music o _ :
—_ . Core 12/22/2018 1:47 PM  File folder
g Vfd ures )} Drivers 12/22/2018 1:47 PM  File folder
1dees — | [ Middlewares 12/22/2018 1:47 PM  File folder J
L SW4STM32 12/22/2018 1:47 PM  File folder
% Homegroup o _ :
L . TouchGFX 12/22/2018 1:47 PM  File folder
M C 1 J USB_HOST 12/22/2018 1:47 PM  File folder
1 t : . . .
= imp‘: ;_' ‘) [ .mupraject 12/22/2018 147 PM MXPROJECT File 23KB
= Local Disk (C:
= m my_SWA45TM32_STM32F429i_DISC]_proje... 12/22/2018 1:47 PM  STM32CubeMi 35KB

—a Local Disk (E:)
e DIS_F42971 ():)

' 8 items

Enter SWASTM32 -> my_SWA4STM32_STM32F429i_DISC1 projectl folder
Enter the SW4STM32 folder

Enter the SW4STM32_STM32F429i_DISCO (your project name) folder

13



Local Disk (C:) » TouchGFXProjects » SW4STM32_STM32F429i_DISCO » SW4STM32 » SWASTM32_STM32F429i_DISCO »

Iy - Share withl} Burn Mew folder
Name
J settings
, Application
Double-click on | Debug
the PROJECT ) Drivers
file to launch . Middlewares
the SW4STM32 y Release
- ©
compiler IDE ‘E
|
“ 32F429IDISCOVERY

|| STM32F4297TTx_FLASH.Id
|| SW45TM32_STM32F429i_DISCO Run.cfg

[ stm.vorkspace. 122218 TCC+ Edips- MR

File Edit Source Refactor MNavigate Project Window
il | ®-R-Bi@-&-HE-T-%~0
[ Project Explorer 52 = = 8

4[5 SWASTM32_STM32F429i_DISCO
> [l Includes
> (= Application
> (= Debug
> (= Drivers
> (= Middlewares
> (= Release
|%] 32F4291DISCOVERY .xml
|y STM32F4297TTx_FLASH.Id

Search Run

B%E|s

v

Date modified

12/22/2018 10:28 ...
12/22/2018 10:28 ...
12/22/2018 2:49 PM
12/22/2018 10:28 ...
12/22/2018 10:28 ...
12/22/2018 12:48 ...
12/22/2018 10:26 ...
12/22/2018 2:43 PM
12/22/2018 10:28 ...
12/22/2018 10:25 ...
12/22/2018 2:44 PM

Type

File falder

File folder

File folder

File folder

File falder

File folder
CPROJECT File
PROIJECT File

nRFgoStudio.nRFE...

LD File
CFG File

Size

39 KB
19 KB
1KB
6 KB
1KB

Test the wizard generated code by selecting Project -> Clean -> Build All

H"_‘, Project Explorer &3 = <.1='=5 | &
4 Ef? SW4STM32_STM32F429i_DISCO

4 f;?' Binaries

VEE

s % SWASTM32_STM32F429i_DISCO.elf - [arm/le] J

> [ap) Includes

> = Application

» = Debug

> 2= Drivers

> = Middlewares

> = Release
|%] 32F429IDISCOVERY xml
|id STM32F4297TTx_FLASH.Id

Compiled OK

Leave the SW4STM32 window open and return to STM32CubeMX window..



Reset Configuration

@ Farameter Settings @ TouchGFX

Configuration

@ User Constants

@ Platform Settings

[Configure the below parameters :

Q| ' | ® ®
~ Stack Mame
Mame
~ Physical Display Size
Width
Height
~ Frame Buffer
LTDC Pixel Format(Setin LTDC
Frame Buffer Color Format
Calor Frame Buffer Depth
Color Frame Buffer Start Address(Setin LT...
Buffers Count
~ Bitmap Cache Settings

Oitrnmm Mamkhin Addraee

TouchGFX

240
320 Change to match
LTDC_PIXEL_FORMAT _RGBS65

RGB5ES

16

Double Buffered

Reset Configuration

@ Farameter Settings  [ESTAUERIEFE

@ User Constants

® Platform Settings

[Configure the below parameters :

N

| Fora
w2

ot

Q|

~ External application info
Mame
Jersion
w Location
Executable full name
~ |nputs
Physical Display X Siz
Physical Display Y Siz

[i-l [i-l
I I
m [4¢]

= o

TouchGFX Designer
J4.10.0

CATouchGRXW 10 .0designenTouchGFXDesigner-4....

Double-click on
TouchGFX Execute

Launch the TouchGFX tool — remember — do this ONLY ONCE from the
STM32CubeMX tool. If you repeat this launch, all of your GUI development
will be reset to defaults. It is ok to continue the GUI development using the
folder view for this project to launch the TouchGFX project as required.

15



B8 TouchGFX Designer s s

TouchGF! vesioner

STM32F429 Disco
on SW45TM32

Handsome self-portrait with a touch button

16



Simulator

Lo

1. Save your work SCREEN

2. Generate Code

3. Close TouchGFX NAME

Screenl

Configuration

Reset Configuration

@ Parameter Settings  |[NESTaUEhGEAS @ |ser Constants

® Flatform Settings

[Configure the below parameters -

QEaehciFg ] © @ © Xﬂ i

~ External application info

~ Location
Executable full name

CiATouchGRX4.10.0\designenTouchGFglesigner-4.10.0.exe
~ Inputs

DO NOT use this button again to launch TouchGFX to
continue your GUI screen development. If you do, all
work will be reset to DEFAULTS !!!

STM32CubeMX -> Generate code

m Code Generation l |, X J

o The Code is successfully generated under C:TouchGFXProjects/my_SWASTM32_STM32F429i_DISC1_project

o cousr fope et ] cose K0G8 |

17



Goto SW4STM32 compiler window and
refresh the new generated code and links.

File Edit Scurce Refactor Mavigate Search Project Run Window Help

[7 Project Explorer 532 =R | & -~ — O
4 Ef’ SWASTM32_STM32F429i1_DISC
5 f;? Binaries e k
s [al Includes Go Into
> = Application
s [= Debug Open in New Window
(= Drivers -
s = Middlewares = Copy Ctrl+C
. = Release Paste Ctrl+V
|%] 32F429IDISCOVERY xml 3 Delete Delete
1w STM32F42971Tx_FLASH.Id Remove from Context Ctrl+Alt+Shift+ Down
Source k
Mowve...
Rename... F2
fag Import...
g Export..
o 1
Build Project

Clean Project
Refresh F5
Close Project

Close Unrelated Projects

Build Targ >
Index >
Build Configurations >
Validate
Show in Remote Systerns view
Profiling Tools »
Run As »
Debug As »
Profile As »
Restore from Local History...
& Convertto C Console
& Target ]

18



Rebuild
Freshen All Files (

Update with Mudl%ed Files

Re-resolve Unresolved Includes

Search for Unresolved Includes

Project -> Clean
Project -> Build All

Code can now be uploaded to your target kit and the
GUI should appear correctly on the kit but will be
without a TOUCH PANEL.

To upload code to target kit -> Project -> Right mouse
click -> Target -> Program chip -> Press RESET on kit

Uebug As »
Profile As ]
Restore from Local History... |

L Convertto C |

Target L\} ' & Program chip...
“%‘” Run C/C++ Code Analysis &  Erase chip... |
Team 1
Cormpare With L
Configure L3
Source L
Properties Alt+Enter

19



Modifying the SW4STM32 Project for Touch Panel Support

1. Download and extract the latest STM32CubeF4 package from ST website. Version 1.23.0
was used for this tutorial.

2. Copy the Components folder from STM32CubeF4 package to your project folder as
shown. The folder structure is important. NB: The wizard does not generate a
Components folder.

Local Disk (C:) » TouchGFXProjects » SW4STM32_STM32F429i DISCO » TouchGFX »

Burn New folder

Mame Date modified Type Size

s

| assets 12/22/201810:26 ... File folder
J build 12/22/2018 2:47 PM  File folder
12/22/201811:11 ... File folder
12/22/201810:24 ... File folder

, Components

3
A
1
| config
3
A
1

J generated 2/22/4

J gui —

J simulator 127224 <« Downloads » enstm32cubefd » STM32Cube FW_F4 V1230 » Drivers » BSP »
| target 12722
£ output_CompileSimulator 12/224 Organize = = clude in library = Share with + Burn New folder

=
r o
|| output_GenerateAssets 127224 <% Favorites Name
| output_PostGenerate 12/224 P Deskop J| Adafruit_Shield
] output_RunSimulator 127224 18 Downloads Copy the Components | | Companents
= P
B SW4STM32_ STM3ZR4291 DISCO 12"21] % Recent Placesfolder to your local project . STM32F4-Discovery
folder as shown. The e Haco L
4 Libraries target location is 1 STM32F4cc-Mucleo
% Documents N rtant | STM32F401-Discovery
m ant.
& Music po bl 0 m
M Components Date modified: 10/26/2018 1:49 PM
}l— File folder
¥

. » lab » Downloads » en.stm32cubefd »

Organize ~ :3] Open Indude in library ~ Share with ~ Burn New folder

p

Name Date modified Type

.0 Favorites
ity I | sTM32Cube FW_F4 V1.23.0 10/26/2018 1:49 PM  File folder
| . Downloads

5 Recent Places

l&. Google Drive

% Dropbox - E =

® STM32Cube FW_F4 V1.23.0 Date modified: 10/26/2018 1:49 PM
r\n File folder

20



()% |« enstm32cubef4 » STM32Cube FW_F4.V1230 » Drivers » BSP »

PEEE |

v 4y || Search BSP

R

:,3 Open

Organize ~

-~

1.7 Favorites
M Desktop

| . Downloads

_.E} Recent Places
le. Google Drive

% Dropbox

1

Include in library ~ Share with ~ Burn New folder - H @
rs

Name Date modified Type -

| STM32F411E-Discovery 10/26/2018 1:49 PM  File folder

| STM32F413H-Discovery ’ 10/26/2018 1:49 PM File folder =
‘ | STM32F429I-Discovery 10/26/2018 1:49 PM  File folder

| STM324x91 EVAL 10/26/2018 1:49 PM File folder

| STM224vis FVAI 10/26/701R 1-40 DM Fila faldar h

STM32F429I-Discovery Date modified: 10/26/2018 1:49 PM

File folder

Drag & Drop the highlighted files from the STM32CubeF4 folder to your project:

& stm_workspace 122213,

File Edit Source Refactor Mavigate Search Project Run Window Help
BRI ®-R-BiEg-&8-B-G-it-0-0-% i@ /-FeREMH-H-HE-o-
[ Project Explorer 33 %)% v = 0O [§STM32MTouchControllercpp  [5] BoardConfiguration.cpp | [£] stm32f429i_discovery.c 33
4[5 mytest2 SWASTM32_STM32F429i_DISCL 559 LCO_WRX_HIGH();
& )l Includes 560 e s Lot high 7
561 : Chip Select hig
4 i Application EE: LCD CS HIGH();
b SWASTME2 —rey %
4 5 User p—
b g Core @O-| 1 « Drivers » BSP » STM32F429I-Discovery ~ %3] [[searcn st -Discovery o]

4 5= TouchGFX
[ [ generated
b & gui
4 = target
» [§ BoardConfiguration.cpp
[ GPIO.cpp
[ HW Init.cpp
[€) stm32f429i discovery i

8 stm32f429i discovery.c
Bl stm32f429i_discovery.h
[§ STM32F4DMA.cpp
[§ STM32FAHAL.cpp
[ STM32F4Instrumentation.cpp
[ STM32F4TouchController.cpp
b = USB_Host Library
» ¢= Debug
[ (= Drivers
b = Middlewares
[¥] 32F429IDISCOVERY.xml
Iﬂ STM32F429Z1Tx_FLASH Id

vevwwvRmw v v v ey v

Organize +

¢ Open

Share with ~ Bum

New folder

- 0 @

2] Recent Places

o Libraries
% Decuments
& Music
[E=] Pictures

B videos

ﬁ Homegroup

8 Computer
&, Local Disk (C)
a Local Disk (E)
s DIS_F42071 ()

I-m-u

STM32C
package

F4

Drag & Drop the
highlighted files
into your
SW4STM32 project

Select COPY files
when prompted

6 items selected Date modified: 10/26/2018 1:49 PM

Size: 711 KB

Name

B Release Notes

Date modified

10/26/2018 1:49 PM

| B stm326429i discovery.c

10/26/2018 1:49 PM

| B stm32f429i_discovery.h

10/26/2018 1:49 PM

[ stm32429i_discovery_eeprom.c
stm32f420i_discovery_eeprom.h
[ stm32f429i_discovery_gyroscope.c
[# stm32429i_discovery_gyroscope.h

10/26/2018 1:49 PM
10/26/2018 1:49 PM
10/26/2018 1:49 PM
10/26/2018 1:49 PM

| B stm32i420i discovery io.c

10/26/2018 1:49 PM

| @ stm32f429i discovery_ioh

10/26/2018 1:49 PM

[&) stm32429i_discovery_led.c
[ stm32f429i_discovery_lcd.h
[ stm32f429i_discovery_sdram.c
[ stm32f429i_discovery_sdram.h

10/26/2018 1:49 PM
10/26/2018 1:49 PM
10/26/2018 1:49 PM
10/26/2018 1:49 PM

| B stm32f420i_discovery_ts.c

10/26/2018 1:49 PM

| stm320429i discovery_ts.h

10/26/2018 1:49 PM

@ STM32F4291-Discovery_BSP_User_Manual

~ 4 . |

Date created: 11/29/2018 9:48 PM - 12/22/2018 11:51 AM

10/26/2018 1:49 PM

el

¥ fparam Addr: I2C Address
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F B
& File Operation ﬁ

Select how files should be imported into the project:

@ Copy files J

(71 Link to files
Create link locations relative to: | PROJECT _LOC

Configure Drag and Drop Settings...

@ [ ok [ cancel

Select COPY FILES when prompted

; SW4STM32_STM32F429i_DISC1 » TouchGFX » targ

= - -

2w folder
Marme } Date modified Type Size
*+ BoardConfiguration.c 12/22/2018 219 PM  C++ Source TKB
++ GPIO.cp i " 12/22/2018 319 PM  C++ Source 1KB EeDVLEEsapS
++ HW_Init.cpp 12/22/2018 319 PM  C++ Source sie files from the
B HW_Inithpp 12/22/2018 319 PM  C/C++ Header sk STM32CubeF4
++ STM32FADMA.cpp 12/22/2018 319 PM  C++ Source 9 KB BSP ->
[ STM32F4DMA.hpp 12/22/2018 319 PM  C/C++ Header KB STM32F429i-
*+ STM32F4HAL.cpp 12/22/2018 319 PM  C++ Source 4 KB DISCOVERY
S5TM3ZFAHAL hpp 12/22/2018 319 PM  C/C++ Header 5KB folder
*++ STM32F4Instrumentation.cpp 12/22/2018 219 PM  C++ Source 3KB
[0 STM32F4Instrumentation.hpp 12/22/2018 319 PM  C/C++ Header 3KB
*++ STM32F4TouchCentroller.cpp 12/22/2018 227 PM  C++ Source 1KE
[0 STM32F4TouchController.hpp 12/22/2018 219 PM C/C++ Header 3KB
[ stm32f429i_discovery.h 10/26/2018 1:43 PM  C/C++ Header 14 KB
[ stm32f429i_discovery_ts.h 10/26/2018 1:49 PM  C/C++ Header 4 KB

Inside the target sub-folder of your project, copy the shown 2 files from the STM32CubeF4 download



Edit STM32F4TouchController.cpp and change as shown:

[ Project Explorer 52

4 5 SWASTM32_STM32F429i_DISCO
b 4, Binaries
> @l Includes
4 (= Application
> (= SWASTM32
4 (= User
> (= Core
4 (= TouchGFX
> (2= generated
b = gui
4 [= target
> [§ BoardConfiguration.cpp
> L5 GPIO.cpp
> [& HW Init.cpp
> [g) stm32f428i_discovery_io.c
> [B stm32f420i_discovery_io.h
o L€ stm32f420_discovery_ts.c
> [B stm32f425i_discovery_tsh
o g stm32/4207 discovery.c
> gy STM32F4DMA.cpp
> [ STM32FAHAL.cpp
o [g STM32FdInstrumentation.cpp
& [ STM32F4TouchController.cpp
> (= USB_Host Library
> (= Debug
b (= Drivers
> = Middlewares
b (= Release
%] 32F4291DISCOVERY.xml
% STM32F429ZITx FLASH.Id
SWASTM32_STIM32F428i_DISCO Run.cfg

Or copy and paste the following working code changes and delete the original wizard code:

BE&|%

- =g

~ e

e s m e W

12 }
13
14 using namespace touchgfi;
15
2165 void STM32F4TouchController::init()
7
18 /* USER CODE BEGIN F4TouchController_init */
19
20 /* Add code for touch controller Initialization®/
21 BSP_TS Init(LCD GetXSize(), LCD_GetYSize());
23 /* USER CODE END F4TouchController_init
24 }
25
226 bool STM32F4TouchController::sampleTouch(int32 t& x,

[ STM32F4TouchController.cpp 5%

Binclude <STM32F4TouchController.hpp>

/* USER CODE BEGIN BSP user includes */
#include <stm32f429i_discovery_ts.h>
/* USER CODE END BSP user includes */

extern "C"

uint32_t LCD_GetXSize(

IH
uint32_t LCD_GetYsize();

/* USER CODE BEGIN FaTouchController_sampleTouch
TS_StateTypeDef state;
BSP_TS_GetState(&state);
if (state.TouchDetected)
{
X = state.X;
y = state.¥;
return true;

return false;

/* USER CODE END F4TouchContreller_sampleTouch */

#include <STM32F4TouchController.hpp>

/* USER CODE BEGIN BSP user includes */
#include <stm32f429i discovery_ts.h>
/* USER CODE END BSP user includes */

extern "C"

{

uint32_t LCD_GetXSize(
uint32_t LCD_GetYSize(

}

)
)

)
)

using namespace touchgfx;

void STM32F4TouchController::init()

{

/* USER CODE BEGIN F4TouchController_init */

/* Add code for touch controller Initialization*/

BSP_TS_Init(LCD_GetXSize(), LCD_GetYSize());

/* USER CODE END
}

FATouchController_init */

int32 t& y)

bool STM32F4TouchController::sampleTouch(int32_t& x, int32_t& y)

23



{
/* USER CODE BEGIN F4TouchController_sampleTouch */

TS_StateTypeDef state;
BSP_TS_GetState(&state);
if (state.TouchDetected)

{
x = state.X; // Note this change
y = state.Y; // Note this change
return true;

}

return false;

/* USER CODE END F4TouchController_sampleTouch */

}
[c] stm32f429i_discovery.c &3
B59  LCD_WRX_HIGH();
fazate]
861 * Deselect: Chip Select high */
862 LCD_CS HIGH{);
863
864 return readvalue;
865 }
Comment out the
863 ¥ @brief Wait for loop in ms. -
269 * :ﬁ,pa-'a“' EE-_EI'}-' in ms. dupllcate LCD_DEIaY
g7e -
8712 f/void LCD Delay(uint32_t Delay) fl.lllctlon
872 //{
873 // HAL_Delay(Delay);
8

l

Ln

Remove the duplicate LCD_Delay routine using the // (comments tags).

Recompile All -> Upload to your target kit to test. Now Touch Panel should be functional ©

Reminder WARNING: If you wish to revise your TouchGFX project, you may do so but must be done
through the File Manager -> TouchGFX folder for this project. Otherwise, if you do select the EXECUTE
button (after the initial launch) from the STM32CubeMX tool then your GUI screens will be reset to
DEFAULT.

Known Issues

e This documentation is only a work-around till the respective tools are properly integrated

e Current SW4STM32 project appears to only properly DEBUG build, the RELEASE build settings raises
an error. If known, please email or post a solution in the ST user forum on how to create a RELEASE build
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Comments / Suggestions / Compliments / Error reports / Dog Biscuits to: Kumar[at] softio.com

Full project may be downloaded from here (hosted on our company server):

https://axxonshare.s3.amazonaws.com/my combo tutorial.zip

25


https://axxonshare.s3.amazonaws.com/my_combo_tutorial.zip
https://axxonshare.s3.amazonaws.com/my_combo_tutorial.zip

